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1 Disclaimer

This user manual introduces the user to the operation of the crowd:it software. The
models and algorithms implemented in crowd:it are derived from accepted and recent
research literature. Nevertheless, accu:rate cannot assure that reality will not deviate
from any and/or all simulation results. The proper use of crowd:it is the sole responsibility
of the user.
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2 Introduction

Congratulations! You have selected one of the most advanced pedestrian simulators on
the market. Founded in 2014, following studies at the Technical University of Munich
(TUM), accu:rate GmbH provides the latest research in crowd simulation to practitioners
including engineering firms, event organizers, crowd managers and firefighters. Regardless
of the scenario type; be it low numbers of people in an office, or enormous industrial
complexes, museums and outdoor events, the state-of-the-art mathematical models at
the core of our software deliver valid results you can trust. With crowd:it’s clean and
self-explanatory user interface, you can focus on the project and not the software.

The following documentation serves as a reference. Online video tutorials and in-person
training sessions are also available.

2.1 Document Structure

The structure of this documentation is based on the workflow of a project. Typically, this
begins with simplifying engineering plans, before marking specific objects and surfaces as
Simulation Objects (e.g. entrances). For this, commercially available 2D CAD software
packages are suitable, e.g. Autodesk™ AutoCAD. Plans created in the CAD software
can be directly imported into crowd:it. Next, pedestrian (hence-forth named agent) plans
and movements are modelled and, in a further step, their behaviour analyzed. Finally,
the results are created and exported.

We wish you every success with your crowd:it project!

7



3 crowd:it Introduction

3.1 User Interface

The user interface is divided into several areas, which are explained below.

3.1.1 Menu

At the top of your screen you will find the Menu Bar. Here several menu items can be
selected. The menu is modelled on project workflow: work from left to right.

At the far left is File. Here you can open and save simulations (and create Screenshots
and Videos)

Next to File is Edit. All parameters for the simulation are defined here and floors can
be managed.
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Under the heading Simulation individual or statistical simulation runs are managed.

Visualize allows you to visually analyze a simulation. Some visualisations are only relevant
after your simulation has run, so it will be available only with simulation results.

The penultimate menu, Analyze is also only available after a simulation run. Here you
will find a variety of tools to quantitatively evaluate your simulations (e.g. identifying
individual agents and their routes, or providing a Heatmap of density throughout
the simulation).

3.1.2 Play Bar

The Play Bar is only available if a simulation has already run. With it, a simulation
can be played, paused and rewound. What’s more, your simulation can be restarted and
in “paused” mode, micro time-steps considered. Along the bar, you can identify exactly
where you are in the simulation and move forward or backward as you wish.

3.1.3 Floor plan view

The floor plan view displays the simulation. Here, you can view and edit your simulation
directly in the imported floor plan.

Move within the map by pressing down on the scroll wheel and dragging, or use your
keyboard’s arrow keys. Additionally, you can center the map under Visualize > Center
floor; shortcut Ctrl+J.

3.1.3.1 Selection behaviour

Some elements like simulation objects and agents can be selected directly in the plan
view.

The following basic conventions are used in crowd:it:

3.1.3.1.1 Left mouse click: Selection of elements For the selection of elements crowd:it
provides several selection types. Elements can be selected by simply clicking on them or
by dragging a selection rectangle.

Independent of the selection type, the selection can be influenced with some keyboard
keys. If no key is pressed, the default selection method is used, the previous selection is
deleted and a new selection is started.

The following selection modes are available:
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SHIFT key: new elements are added to the current selection.
STRG key: elements are added to the selection if they are not in the current selection, if
they are already in the selection they are removed
SHIFT and CONTROL simultaneously: deselect elements

3.1.3.1.2 Right mouse click A right mouse click on a clickable object brings up a
context menu that allows individual quick actions depending on the object type.

3.1.3.1.3 Left double click A double click opens properties of the clicked object.

3.1.4 Information Panel

Next to the floor plan a panel is displayed. This panel provides useful information for
you during the design and analysis stages of your simulation. We will now discuss the
two panels separately.

3.1.4.1 Properties panel

During the modeling phase, this tab provides information about the currently selected
objects in the floor plan.

As long as no object is selected, the tab shows general information. This information
includes the total number of agents in the scenario and per floor.

When one or more objects are selected, the top pane shows a table of all currently selected
simulation objects. If you right-click on any element in this table, the context menu of
the object is displayed (analogous to a right-click in the Floor plan view).

The lower area contains detailed information about the object selected in the upper
area. This area is composed of four different tables. The first table shows some general
information about the simulation object (Important: this table shows different information
depending on the simulation object type of the selected object). The remaining tables
contain information about which paths, pathsnippets or sets the object is contained in.
A right mouse click on a table entry opens a context menu appears with further options
for editing or displaying more details.

If simulation results are available, and you have selected one or more agents in the Floor
plan view, the tab shows information about the selected agents.

Right-click on the column header to filter specific information for a better overview.

By right-clicking in the table, a context menu appears, which can be used to display
further details about the selected agent (e.g. which objects make up the completed path
and which concrete objects were selected).
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When multiple agents are selected, it is possible to scroll through the details of each one
individually, as well as show to show a summary of all selected agents.

3.1.4.2 Result information panel (only visible when results are present)

When simulation results are available, the Results Information panel is displayed. This
panel contains summary data about your simulation results, including information about
the use of origins and destinations as well as the number of generated agents and their
distribution among origins and destinations.

3.1.5 Toolbar

The toolbar offers you various tools with which you can edit or analyze your simulation.
By default, the selection tool is active that allows you to select simulation objects.

If no simulation results are available yet, a tool for editing the geometry of simulation
objects is available. Select the “Edit” tool, and then click on the simulation object whose
geometry you want to change. After that, the corner points of the object will be displayed,
which you can now select and move. You can also select and move multiple vertices; with
the key combination Ctrl+A you can even select all points to move the entire object.
The Information Panel also offers you the possibility to delete the selected points, or
to insert new points between the already selected points.

Then follow tools to create new simulation objects. On the one hand you can create
a general simulation object as you know it from the CAD import, and then assign a
simulation object type. On the other hand, you can also directly select a simulation
object type, such as origin or destination. Then, after creating the object, the properties
dialog of this type will open immediately.

If simulation results are already available, a tool for selecting agents is available instead.

In addition, there are tools for creating evaluation objects, regardless of whether simulation
results are available.

3.2 Step-by-step Modelling Process

Our modelling process is as follows:

11



3.2.1 Step one: Edit

In this step the parameters of the simulation need to be defined. The parameters include
the geometry (environment of the simulation), agent population, movement strategy and
so on.

3.2.2 Step two: Simulate

This is the most passive step of the simulation creation. Here the simulation calculation
is started and the computer takes over the work.

3.2.3 Step three: Visualize

After the simulation calculation is completed, the simulation can be viewed. In this step,
still existing modeling errors are noticed and one can return to step 1. Otherwise, the
user can start to export screenshots and videos of the simulation. Color pedestrian by
specific attributes (velocity, congestion, etc.)

3.2.4 Step four: Analyze

After the simulation calculation is completed, the simulation can be viewed. In this step,
mostly still existing modeling errors are noticed and one can return to step 1.

3.3 Quick Intro

Our Quick Intro, accessed via the Welcome screen and Help menu, introduces you
to the most basic crowd:it functions:

• Creating an Origin
• Creating a Destination
• Creating a Path
• Running a Simulation
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3.4 License

With Help > License Details you are able to view and edit your current license
details.

3.5 Updates and Assistance

3.5.1 Documentation

With Help > Open documentation you are able to view the documentation corre-
sponding to your crowd:it version.

3.5.2 Updates

Each time you open crowd:it, our software will search online for a newer version. If a
newer version is available, updates will download in the background automatically. As
soon as the download is complete, you will be notified in the lower right corner of crowd:it.
By selecting this notification, you can close your current version of crowd:it and open the
same project again in the updated version. Alternatively, the newer version of crowd:it
will be used automatically the next time you open the software.
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3.5.2.1 Version Conversion

Some updates require an updated file format. To convert existing files to the new format,
crowd:it offers an automatic conversion. A dialog appears automatically the next time
the file is opened. Here the conversion process can be started. The old file is kept during
the conversion, a new file is created and can be saved with Save > Save as.

3.5.3 Help

With Help > Get help from accu:rate you can create a Support Request, which is
sent directly to accu:rate. Use Support Requests to communicate problems you encounter,
or to suggest software changes. Simply fill in the form. For privacy, the field Project
Details is by default unchecked. In most cases it will be difficult to assist you without
more details so be sure to check this box where appropriate.

3.5.4 About

With Help > About. . . you can view the version of your crowd:it installation including
the individual version number of the graphical user interface (Gui) and the simulation
calculation unit (Kernel). Here you also have access to the link to the current changelog.
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3.5.5 Escape (ESC-Key)

Press Esc to abort an action.

Abort from:

• the creation of paths
• drawing or moving evaluation lines or polygons
• following an agent
• editing any settings (Cancel acts similarly)
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4 General

There are some recurring behaviors within the software. These will be discussed in more
detail in this chapter.

4.1 Distribution

For example, to generate different people, multiple distributions are needed. On the one
hand for the generation of the desired speed, the size as well as the premovement time.

Within crowd:it three different distributions are available:

• Normal: Distribution according to the Gaussian distribution - i.e. the probability
of certain values follows a Gaussian bell, values close to the center are chosen with
a higher probability than values close to the limits

• Uniform: Uniform distribution between two limits - all values within the limits are
equally distributed

• None: Assignment of a single value for all
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5 crowd:it and CAD software

In order to simulate agents in an environment, you first require a plan of that environment.
Plans should be generated in CAD software and then imported into crowd:it. Elements
that have a special function in the simulation must be modelled as generic “Simulation
Objects” in your CAD plan and will later be assigned their function in crowd:it ( see
Simulation Objects).

This chapter explains how to create Simulation Objects.

Note: Simplicity in your plan is key. Simplification saves simulation time – every line of
your plan affects the computation time – and provides clarity. Especially for complex
simulations with a high number of people, any simplification is welcome.

5.1 dxf Format

Most CAD softwares allow exporting .dxf files. Those dxf files can afterwards be imported
in crowd:it, this enables crowd:it to work with many different CAD programms.

Important: In order to use the exported files for the simulation, the identifiers of the
objects must remain the same even if they are exported several times or deleted from
other objects. This is ensured by most CAD software. Compatible, tested CAD software
can be found here: https://www.accu-rate.de/en/compatible-cad-packages/.

5.1.1 Creating Simulation Objects

Simulation objects are elements that are assigned a specific function in the simulation
context. Simulation objects can be created as follows:

• Add the word “crowdit” to the layer name on which these objects are placed.
Example: a layer “crowdit-stairs” where all stairs of the floor plan are located.

• Set the color of the layer or an object to RGB-“232/78/15” (or “#e84e0f” in
hexadecimal).
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5.1.2 Allowed element types

crowd:it recognizes the following CAD element types: ‘lines’, ‘polylines’, ‘circles’, ‘arcs’,
‘ellipses’, ‘solids’, ’ splines’, ‘LWPolylines’ and ‘lines’. Elements inside Blocks are imported
accordingly.

Other elements, such as Hatch, Text, Image etc. will be ignored.

5.1.2.1 Layers

CAD files are typically divided into layers. These are used to sort different elements and
floors. To prepare the CAD file for crowd:it, it is best to create a separate layer for each
type of simulation object (e.g. source, destination) and for each floor and name the layer
in a meaningful way (e.g. basement-crowdit-origins, first-floor-crowdit-destinations etc.).
This will help you keep track of things and make it easier to edit changes.

Note: Frozen layers are not imported into crowd:it. Therefore, frozen layers can be used
for layer control: it can be used to manage all floors of a building in the same CAD plan,
but by freezing specific layers (this is also possible by grouping the layers) only those
layers that belong to one floor are exported at a time. A short video from AutoCAD on
how to create layer groups can be found e.g. here.

5.1.2.2 Check Units and Scaling

In order for the exported geometry to be consistent, and consequently the simulation to
be realistic, plans must be to scale. Check the units.

5.1.2.3 Exporting crowd:it-scenarios to DXF

crowd:it offers basic exporting functionality to generate DXF files from crowd:it floor
plans. As the internal format stores only a subset of the information in the original DXF,
we recommend using this feature only if the original DXF file does not exist anymore
and changes to the floor plan are necessary.

The recommended workflow for incorporating changes is to change the original DXF,
and then re-import that. This will update changed geometry while keeping the model
generated in crowd:it.

The export command can be found in the Main menu under Edit.
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5.2 Vectorworks

Export your drawing directly to a crowd:it .floor file using our Vectorworks Export
Plugin. Download the Plugin here. We offer a video tutorial explaining the installation
of the plug-in as well as a short demo video showing Vectorworks 2019 and crowd:it in
action. Be advised the Vectorworks DXF export will break re-importing changed floors -
use our plug-in instead.

Creating a simulation with Vectorworks is very similar to using other CAD software.
Create Simulation Objects by setting your layer’s colour, including crowd-it in the name
of a class, or, especially for Vectorworks, using a Vectorworks database.

5.2.1 Creating Simulation Objects using a database

By using databases to create Simulation Objects, you need not reorganize your drawing,
as you would for class naming and colour setting.

5.2.1.1 Using the Plug-In

The plug-in installer provides a menu item named Tag as crowd:it simulation object.
Select the geometry objects you wish to become Simulation Objects in crowd:it and click
on this menu item. It will carry out all necessary database tasks automatically.
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5.2.1.2 Manually

Create a database named dbase_crowdit with a single Boolean named crowdit-obj,
whose default is true. Any geometry added to this database will become a Simulation
Object in crowd:it.

5.2.2 Creating a floor plan from a 3D Model in Vectorworks 2019

A 3D model is an excellent basis for a simulation in crowd:it. To work with a 3D model,
use horizontal cuts to separate floors. To do this:

1. Use Clip Cube (DE: Schnittbox) to create a “horizontal section cut” through
your model, including all geometry relevant to your floor.

2. Right-click on your horizontal cut and select Create section viewport... (DE:
Schnitt anlegen...). In Vectorworks 2019, the context menu has this option
twice. Select the latter – the final menu option. Note: Set the scale as 1:1.

3. In your newly created cut, select all objects and from Modify (DE: Ändern) select
Convert > Convert to Group.... (DE: Symbol/Objekt wird Gruppe...) to
turn all intelligent objects into plain geometry.

4. Copy all these objects into a new document. This pastes all objects to a construction
layer - layout layers are not exported into the crowd:it floor file.

5. Continue your work as normal in the new plan: Create a crowdit class, add
Simulation Objects, etc.
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6 Floor

So-called floors are used to describe the simulation environment. This chapter gives an
instruction how to import, edit and delete floors.

6.1 Import

After creating a new simulation file, floors are required, upon which agents can move.

In order to import your floor(s), head to the Menu Bar and select Edit > Add
floor. . . .

With Add floor. . . .dxf files can be selected. If a floor already exists, Add floor. . .
will ask whether you would like to replace or insert a different floor, whose name you
can edit later.

In order to change individual Simulation Objects, each object must have a unique name.
If not, the user will be notified and the import will be blocked.

For replace, there are three reasons adding a new floor may be blocked:

• Duplicate: One of your current floors (one you do not wish to replace) has the
same ID as the floor you are trying to import.

• Incompatible changes to the geometry: A former staircase is now a triangle, and a
former escalator is now a circle etc.

• Simulation Objects with a feature in the current floor are not in the floor you wish
to add.

For insert, there is one reason adding a new floor may be blocked:

• Duplicate: One of your current floors (one you do not wish to replace) has the
same ID as the floor you are trying to import.

If a floor is unsuitable for replacement or insertion, the OK button is deactivated, a (!)
is displayed and more detailed information is available by hovering over the highlighted
floor.
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6.2 Properties

With the menu option Edit > Properties of current floor. . . the properties of the
current open floor can be viewed and edit.

Name Identifier for this floor.
Height The Height variable defines the height of a floor in meters.
Elevation Elevation specifies the position of one floor relative to all the others. By

default, this is set to 0.
Cell Dist Here the discretization of the floor can be set in metres.

With the menu option Rename current floor. . . the current (open) floor can be
renamed. Duplicate names are not permitted.

6.3 Reorder

Here you can change the order of the floors. E.g. the cellar is actually above the basement,
not the other way round.

6.4 Delete

With Delete current floor the current (open) floor is deleted. If you choose to delete a
floor containing a Simulation Object, a warning will display.

6.5 Directly editing via floor popup menu

To edit the properties of a floor, delete or replace it or insert another floor after this
floor, right-click on the floor’s tab (just above the Main Visualization Window).
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7 Simulation Object

After importing a floor file all Simulation Objects will be initially orange.

Use a right-mouse-click on an object and select Create to open a dialog, where you can
specify the function of an Object, e.g. Origin, Destination, etc. If several Simulation
Objects lie on top of one another, a menu will ask which Object you wish to work with.
To manage multiple objects at once, select them by dragging a rectangle over the Objects
you wish to select. When dragging from left to right, an Object is only selected if it lies
completely inside the selection rectangle; when dragging from right to left it is sufficient
if only a part of the object intersects with the selection rectangle. It is also possible to
individually select additional objects by clicking the left mouse button while holding
down Control.

The following Simulation Objects can be assigned:

• Origin: Sources of agents who are generated either immediately or gradually
throughout the simulation.

• Destination: Targets that “pick up” agents. They can also be considered sinks that
remove agents from the simulation.

• Scaled Area: Areas that decelerate or accelerate agents.
• Directed Scaled Area: As with scaled area but with an added directional variable.

Accelerate and decelerate agents based on their direction.
• Waiting Zone: Areas in which agents wait.
• Stair: Stairs can connect two floors.
• Escalator: Escalators can connect two floors.
• Elevator: Elevators can connect multiple floors.

Simulation Objects that can be created from lines:

• Queuing Line: Elements representing the start point of a queue.
• Portal: “Teleporters” that connect two floors.

After selecting one of the above, a settings dialogue will open. Generally speaking, the
dialogue contains the name of the Simulation Object and settings corresponding to its
type. If a setting is invalid, a red ! will display. Move your mouse over the ! to display
details of the error. Each dialogue is described below.
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7.1 Origin

A Origin generates agents within the simulation. To do this, some parameters need to
be set.

To simplify the setting of the parameters, the dialog is divided into several tabs. Normally,
only the first tab is required. For comprehension, each tab will be explained individually.

7.1.1 Generation intervals

To generate the agents, the generation period (interval) and the number of agents
must also be specified. Each origin can have multiple intervals in which agents will be
generated.

For each interval the following information must be set:

From (s): The time at which the first agent is generated (in seconds).

To (s): The time at which the last agent is generated (in seconds).

No of Agents: Number of agents to be generated in this interval.

7.1.2 Personas

Within on origin different types of pedestrians can be generated. For this purpose, it is
necessary to specify how many percent per persona should be generated in this origin.

Additionally, this tab allows to create new personas.

7.1.3 Premovement time

In addition to the generation intervals, a premovment time can be assigned to the agents.
This is used to model response times (for example, until people actually respond to a fire
alarm). It describes the time agents will not move after being generated.

The premovment time can be set as follows:

Same for all agents: If selected, all pedestrians will be assigned the same premovement
time within the premovement time interval. If not each pedestrian within this origin gets
its own unique premovement time within the interval.

Distribution: Different distributions can be selected for the assignment of the premov-
ment time. See chapter distribution for more information about different distributions.

If the agents should start walking immediately, a premovement time of 0 can be set.
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7.1.4 Advanced Settings

In this tab all advanced settings are located.

7.1.4.1 Placement

First of all the origin must know, how the agents should be placed. The placement can
be random (no specific placement set) or sorted.

If agents are placed sorted, they are placed on a regular grid. Each agent will have the
same “comfort distance” between it and any other agent. As such, a uniform emergence
occurs.

Example: Sorted Birth Cells vs. Random Distribution

7.2 Destination

Destinations remove agents from the simulation.

Within the destination dialog there is an “advanced” area. This is not needed in most
situations and can then simply be skipped.

Within this section, intervals can be added to the destination. With this option, people
are removed from the simulation only within the specified intervals. This can be used for
example to represent a bus stop.

You will also see the option: Disable Dynamic Flooding. Dynamic flooding of a
destination affects the performance and quality of your simulation. Essentially, with
dynamic flooding your simulation will be more realistic but slower to run. For test cases
or simple simulations dynamic flooding can be disabled to speed up simulation time.

If you wish to switch off dynamic flooding for all Simulation Objects use the Simulation
settings menu and set the property Use dynamic floor field to FALSE.
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7.3 Scaled Area

With Scaled Areas agents’ speeds can be adjusted, modelling ramps or undesirable
areas etc. Use Scale to decelerate by some factor (<1) or to accelerate by some factor
(> 1).

By selecting scaledArea from the menu, you will be asked to specify your acceleration
factor.

Example: By setting the acceleration factor to 0.7, all agents would decelerate to 70% of
their desired speed.

The checkbox “Only for Navigation” allows to consider this area during route selection,
but an actual deceleration of the agent within the area does not take place. This enables
the mapping of e.g. safety lanes on platforms or one-way streets.

7.4 Directed Scaled Area

Directed Scaled Areas accelerate and decelerate agents according to their direction of
travel. This represents, for example, ramps or simplified stairs (upwards vs. downwards).

After selecting directedScaledArea, choose the direction of the acceleration field (re-
garding its x and y coordinates). Following this, specify the acceleration factor in both
directions (e.g. one direction slower than the other perhaps).

Here a Directed Scaled Area is created that accelerates an agent to 1.5 times its desired
speed if it travels from left to right. If an agent travels from right to left, it will slow to
half its desired speed through this area.

To change the direction of the acceleration field, it is also possible to use the tool icon.
The tool icon will cause a frame to popup, in which you are able to specify the direction
of your acceleration field by clicking directly on the circle on the upper half of the frame
or by entering the degree of the direction vector in the lower half. In either case, the new
direction will automatically translate to the (x/y) form.

As with Scaled Areas, the “Only for Navigation” checkbox can also be checked for directed
fields.

7.5 Waiting Zone

Two different waiting behaviors are available for waiting zones. Either each agent has to
wait for a fixed duration or the waiting agents are always allowed to leave the waiting
zones at a fixed time. While pedestrians are waiting, they avoid pedestrians who are not
waiting.
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The capacity defines the number of agents who can reside in a Waiting Zone at the
same time. If you wish there to be no capacity constraint, set this value to “-1”. Note:
For Waiting Zones with a capacity of one, groups are counted instead of the individual
members. If a group of three is next in line to enter a Waiting Zone of capacity one,
they will enter together. This behaviour can be used to model payment counters. E.g. a
family of three buying cinema tickets all at once, while three people not belonging to the
same group buy their tickets one after the other.

7.5.1 Fixed waiting behaviour

If fixed waiting behaviour is chosen, each agent gets a fixed waiting duration assigned
from a set distribution. Also see the chapter Distribution.

The capacity indicates how many agents can be in a waiting zone at the same time. If
you do not want a capacity restriction, deactivate this option. Note: For waiting zones
with a capacity of one, groups are counted instead of individual members. If a group of
three wants to enter a waiting zone with a capacity of one, it will enter together. This
behavior can be used to model checkouts. For example, a family of three buys movie
tickets all at once, while three people who do not belong to the same group buy their
tickets one after the other.

7.5.1.1 Meeting zone

The “Meeting zone” option can be used to define waiting zones as meeting points. The
agents gather in the waiting zone until the capacity is reached, and then depart in unison.
In addition, agents also leave the waiting zone if the waiting time has been exceeded.

7.5.2 Schedule waiting behaviour

In the case of a scheduled waiting zone, only the length of the recurring interval must be
specified. At the end of the interval, pedestrians are allowed to leave the waiting zone.

7.5.2.1 Recurring

Here you can set some time (in seconds) after which the capacity of your Waiting Zone
will renew. That is, your Waiting Zone is not closed.

7.5.2.2 Custom

Here you can specify custom intervals with different capacities for your waiting zone.
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7.6 Queuing Line

A Queuing Line is a linear object where agents will form a queue. The queue can be
sorted (agents queue one after another in a single line) or unsorted (agents wait behind
the line and tend to enter the queue at somewhere at the end).

Queue Lines can have an Orientation, which defines the side of the line where agents
wait. This is indicated by an arrow in the floor plan. If no direction is set, the agents
automatically wait on the opposite side of the Waiting Zone.

The next element in the path determines for which element the pedestrians queue. They
will continue to walk to the next element, when it has free capacity.

A sorted queue will look something like this:

Note: If agents are queueing for an object, the Queueing Line represents a “stop
point”, with the queue growing perpendicular to it. (Advanced: Small deviations from a
straight line queue can be selected in Queue behaviour under Max queue deviation.
The distance between each agent in a queue can be specified similarly under Comfort
distance in queue).

For more on our queuing model see Our Queueing Model.

7.7 Stair

Stairs can only be created on rectangular objects. If stair is unavailable (greyed out),
your Stair geometry is not rectangular. Change this in your CAD software.

Besides the orientation of the Stairs, you can change the number of treads. You will get
warnings if the number you entered translates into invalid tread depths (minimum is
0.15m, maximum is 0.4m, default is 0.25m) given the Stair’s overall length.

Use the Turn 90° button to change the orientation of your Stair. The arrow drawn on
the Stair indicates its upward-facing direction. The Stair in the previous screenshot has
its lowest z-coordinate on the left side, and its highest on the right.
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A new Stair will not automatically connect to another floor. If unchanged, agents will
traverse the Stair (given it lies on their path), but will not move to another floor. Select
which floors to connect to under, Connects to floor.

Once your Stair connects to another floor, agents will switch to that floor in the center
of the stair. It will become partially transparent and the Flip sides button will appear.
The remaining part of the stair will appear on the connected floor.

7.8 Escalator

As with Stairs, Escalators can be assigned only to rectangular objects. Opposed to
stairs, you need to specify a tread depth instead of directly defining the number of treads.
The minimum tread depth is 0.3m, the maximum 0.8m and the default is 0.4m.

Escalators provide two additional options:

• With Speed in m/s you can alter the Escalator’s speed.

• Change the Escalator’s direction of travel using the Flip travel direction but-
ton.

Here, the Escalator is lowest on the displayed floor and highest on floor “flo1”. The travel
direction is upwards, meaning agents enter on the displayed floor and travel to flo1.

If a Stair or Escalator doesn’t meet your modelling-needs because you need a non-
rectangular stair or one that can be entered from the side - use a Scaled Area or a
Directed Scaled Area instead.

7.9 Elevator

An Elevator connects multiple floors. Adjust an Elevator’s Boarding time and Capacity
in the dialogue’s respective fields. Deselect unattainable floors under Floors to stop on,
and in the Journey-time matrix, describe the travel times between each floor pair. Using
the Reset button, all travel times can be reset to the value defined in the field next to it.
The “home”-floor (upon which the elevator’s geometry sits) is always a stopping floor.

Below, the 5.0 in row 1, column 2 means the Elevator will take 5 seconds to travel from
flo0 to flo1.

Note: Be sure an Elevator can reach every floor required if it is included in a Path.
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7.10 Portal

The following is out-dated. Instead, use Escalators, Stairs or Elevators.

Portals, displayed as a line, link two floors. They represent the “end” of a floor. If you
cannot select portal, it means there is no other floor in the scenario. Another floor must
be created and imported before you can add a portal.

To create Portals: right-click on a Simulation Object line and select portal.

The following menu will appear:

Here the name of the floor to which you wish to connect the current floor must be
specified. In addition, an arrow will appear over the Portal. This indicates the direction
of the Portal’s entrance (i.e. agents should walk into the Portal in this direction).

In order to change the direction of the Portal, right-click on your Portal or use the
Portal’s menu.
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8 Movement strategy

In order for the pedestrians to move in the simulation, they must be assigned so-called
paths. A path describes a collection of simulation objects from source to destination,
which are to be traversed by a pedestrian. A path consists of so-called pathsnippet, set
and simulation objects. Pathsnippets and sets represent subsections of the path and can
contain pathsnippets, set and simulation objects as well. This chapter describes each of
these elements in detail.

8.1 Paths

Paths specify an agent’s targets, and are used in processing its route. Every Path must
start at an Origin and end at a Destination. An agent without an assigned Path remains
in its Origin throughout the simulation. Every Path is assigned a probability (between
0% and 100%), which determines how many agents will take that Path, given other Paths
begin from the same Origin.

The shortest and simplest Path is a direct connection from Origin to Destination. However,
a Path can contain any number of intermediate targets: Simulation Objects that agents
visit in order. The following Simulation Objects can be intermediate targets:

• Destination
• Origin
• Waiting Zone
• Queuing Line
• Stair
• Escalator
• Elevator
• Portal (Legacy)

Things become more complex (and interesting!) when Sets and PathSnippets lie on
your Paths. PathSnippets represent parts of a Path that can be included in multiple
Paths as an intermediate section of each. See: Sets for a definition of a Set. Paths and
PathSnippets follow the exact order they are given. Note: PathSnippets can contain
Sets, and Sets can contain PathSnippets. This can result in potentially high levels
of complexity. However, with prudent use, this functionality is extremely useful for
sophisticated modelling.

31



It is important to note again that Paths must begin with Origins and end in Destinations,
regardless of the number of Sets, PathSnippets and intermediate targets. So, if a Path
begins with a Set, that Set must contain only Origins. Similarly, if a Path begins with a
PathSnippet, that PathSnippet must begin with an Origin or an Origin-set. Respectively
for Destinations.

In some cases, your Path must place certain Simulation Objects in order. For example, a
Queuing Line needs a subsequent Waiting Zone to function. To switch between floors,
use Stairs, Escalators or Elevators.

8.1.1 Creating Paths

Every new Path begins with a right-click on an Origin (Contrary to PathSnippets, which
can begin from, and be attached to, any Simulation Object.).

If an Origin is part of an Origin-set, a new Path can be started here as well.

Now, further Simulation Objects can be placed on the Path or the PathSnippet. If you
select a Simulation Object that is part of a Set or a PathSnippet, you can choose if only
the Simulation Object or the Set or PathSnippet are added to the path.

Each Path must end in a Destination (be it a single Destination, a set of Destinations, or
a PathSnippet(s) ending in Destinations).

At the point you select the Path’s termination point (directly or via PathSnippets or
Sets), a menu slider requests the proportion of agents you wish to use this Path. Any
number of Paths can begin from a single Origin, but the sum of their usage-proportions
must be 100%.

8.1.2 Editing paths

The Paths table displays each simulation Path. Each Path describes completely, from
Origin to Destination, the route of an agent. Any number of intermediate targets can be
defined for each Path.

Paths are the only main building blocks that must always be assigned (all other menu
items are optional). Via Edit -> Paths. . . all existing paths within your simulation
can be displayed.

In this path table each row and row-element can be edited, and right-clicking will allow
you to add or remove rows. In the case of invalid input, the corresponding cell or the
whole line turns red. A message will appear when your mouse rests over the invalid
cell.

The tables can be filtered by pressing the right mouse button on the header of the table.
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The table’s first column offers the unique name of each Path. The second column
determines the proportion of agents (who are born in the Path’s Origin) to use the Path.
Naturally, if an Origin has only one Path, this proportion is 100%. The second column
must in all cases distribute 100% exactly, for each set of Paths that commence from the
same Origin. The final column displays each Path by route. That is, the names of each
way-point (incl. Origin and Destination) of a Path are shown in order, separated by a
comma.

See Visualize Hierarchy to get a tree-like visualisation of the contents of a Path.

8.2 PathSnippets

PathSnippets allow you to group together Sets, other PathSnippets and Simulation
Objects. Unlike a Set, a PathSnippet is ordered, meaning if an agent encounters a
PathSnippet on its overall Path, it will walk each of its elements in order. In a Set, only
one element will be selected based on the given heuristic.

PathSnippets can be traversed in two ways:

In Order: Agents will walk each PathSnippet element in the given order.

Permute: Agents will walk the PathSnippet elements in a random order.

In addition, elements can also be omitted: Each element is visited with the specified
probability - or omitted.

You can assign a capacity to PathSnippets. The capacity limits the number of agents
that may be assigned to the PathSnippet at once. By default, the capacity is unlimited,
which is indicated with a capacity of -1 in the PathSnippet table.

See Visualize Hierarchy to get a tree-like visualisation of the contents of a PathSnippet.

8.3 Sets

Sets allow you to combine any number of Simulation Objects or PathSnippets and can
be nested in one another. You may wish to use Sets for the following reasons:

• To allow agents to choose between simulation objects within Paths, i.e. agents need
to go to a toilet, but it doesn’t matter which.

• To allocate properties to many PathSnippets simultaneously.
• To colour and evaluate the simulation based on a Set of Paths.
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To add a Simulation Object to a Set, right-click the Simulation Object and select Add
to set.... The menu that follows allows you to add the object to an already existing
Set, or create a new one by pressing the create new set button.

To add a “micro” Set to a “macro” Set, right-click on an object that is in the micro Set,
and select Add set to set.

To remove a Simulation Object from a Set, right-click the Simulation Object and select
Remove from set.... The menu that follows shows all Sets the current Object belongs
to and allows you to remove the Object from them.

To get an overview of all the Sets you have, select Edit > Sets. A table including all
the sets of your project will open.

In order to put a Set on a Path, click on a Simulation Object that is part of a Set to
display the so-called “context menu”. Click on “add set” and choose the corresponding
Set that you want to add to the path.

Sets of PathSnippets are also available. The given Set-heuristic will determine which
PathSnippet an agent selects when he comes to a “fork in the road”.

See Visualize Hierarchy to get a tree-like visualisation of the contents of a Set.

Selection Process

When an Agent encounters a Set on their path, they will choose exactly one member
from the Set as their next target. You can select a heuristic, to specify, which of the
available members should be selected.

Advanced users can utilize a more detailed selection process. A selection process comprises
an ordered list of selection modes. To choose a member, the Agent applies the modes
iteratively to the set. Each selection mode discards one or multiple members until only
one member is left. This member will be chosen by the agent.

The following settings regarding the selection process are available: Name: Specify a
name for the selection process. __Active from__: Specify the first second, in which
the given selection process is valid. *Active until: Specify a limit for the validity of a
selection process. Starting with the specified point in time, the given selection process
will be invalid. Selection processes must always cover the entire simulation time, i.e.
another selection process must become active, once the validity of the current selection
process has ended. Select Infinite, to make a selection process valid until the end of
the simulation.

A Set can contain multiple selection processes. Each of them is active in a specific time
frame. The time frames cannot overlap, i.e. there is only one active selection process at all
times. Enter a name in the field Create new selection process and hit the +-button
to create a new selection process. Select a process and hit the --button to remove it.
Select a process and hit the duplicate-button, to duplicate the selected process.
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Selection Modes

Select a selection process to display the selection modes contained in the process.

There are three types of modes available: Best-, Demand-, and Threshold-Modes. To
add a mode to the list, simply press the corresponding button. Hit the - next to a mode
to remove it again. Clicking the sort-button will open a new window, where the selection
modes can be sorted. Click on the blue label of a selection mode, to start editing it,
i.e. to specify the settings that will determine, which members will be discarded by the
mode.

Best

The best mode chooses the “best” member, according to the selected criteria. It discards
all other members, i.e. usually only one member will be left after the best criteria has been
applied unless there are multiple “best” members. The following options are available:

Number of agents: Selects the member with the least number of agents assigned to
it. __Distance__: Selects the member that is closest to the agent. Select farthest,
to select the farthest member instead. Delay time: Selects the member that delays the
agent the least. __Priority__: The priority option allows you to assign a priority to
each member that is contained in the set. The best mode will select the member(s) with
the lowest priority.

Demand

The demand mode operates similar to the best mode, in that it tries to select a single
member that is best with regard to some criteria. However, the demand mode allows
specifying this criteria for each member individually. To be able to compare the members,
it determines a demand for each member and selects the member with the lowest demand.
You can specify a threshold for each member, which marks when the demand reaches
100%. Right-click a member and select a demand type in the popup, to specify, which
criteria will be used to determine the demand.

The following demand types are available:

• Default: Members in the default category will be discarded by the mode.
• Number of agents: The demand will reach 100%, once the member contains the

number of agents specified in the threshold-column.

– at the same time / total: specify, whether all agents that ever visited the
member will be counted, or only the ones currently assigned to the member

– absolute / relative: if relative is selected, the mode will determine the
percentage of agents that it previously assigned to the member at hand. The
demand is calculated by comparing that percentage to the given threshold.
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• Delay time: The demand will reach 100%, once the agent will be delayed by the
time specified in the threshold -column.

• Density: The demand will reach 100%, once the member contains as many agents
per square meter, as are specified in the threshold-column.

Threshold

Opposed to the Best and Demand modes, the threshold mode doesn’t compare members
to each other. Members are again sorted into different categories, and thresholds can
be assigned to them. The mode then discards all members that exceed their threshold.
This makes it very likely, that the mode returns multiple members, which will need to be
filtered again by a different selection mode. There are the same threshold types available
as for the demand mode.

Additionally, there exists the Distance category. It will discard all members, that are
farther away than the given threshold. Select farthest to select members that are
farther away than the given threshold, and discard them if they are too close.

When all members exceed the threshold: The threshold mode usually discards all members
that exceed their assigned threshold and returns the remaining ones. However, in very
special situations, all members might exceed their threshold, which would leave no
member to be returned. Therefore, you can specify what should happen in that scenario:
By default, the mode simply returns the member that is closest to the threshold, even
though it does exceed the threshold. The other options are to choose all members (and let
the next mode decide which member should be selected), or to discard all members (which
makes the agent unable to select a proper member and thus he will stop walking).

Note: Some categories might be missing if the set contains members that are not applicable
for that category.

Choosing multiple best members

The Best and Demand modes offer a setting to Choose the best N members. Usually,
these two modes select the single ” best” member according to some criteria. However,
sometimes it might be beneficial to select multiple best members, for example, the three
closest ones. Use this setting to specify the number of best members that will be chosen.
Select more in the dropdown, to enter an arbitrary number larger than zero.

Agents to consider

All three selection modes offer the option to measure the number of agents assigned to
a member. Use the Consider -section, to set up the condition, which agents should be
included for this. By default, all agents that are currently assigned to a member will be
considered. Change this, to consider only agents once they have reached a member or only
agents that are currently walking towards a member, respectively. The Period-setting in
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the demand and threshold modes needs to be set to at the same time to enable the
Consider -settings.

8.4 Visualize Hierarchy

In the Paths, PathSnippets and Sets table you have the option to see a tree-like visuali-
sation via the context menu.

This view displays Paths, PathSnippets and Sets hierarchically. Each tree-entry may
have its own table of sub-entries, which you can view by selecting that entry.

This can be used to get an overview if your Paths, PathSnippets or Sets are lengthy and
complex. By right clicking on any element of the tree the elements default popupmenu is
displayed. As example the popupmenu for sets allows to directly jump to this set in the
sets table.
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9 Quick Select

With Quick Select. . . an additional window will allow you to select and alter several
objects simultaneously.

The selection process works by applying a series of filters to your objects. The first filter
is object type:

• simulation objects (assigned with type Origin, Destination, etc.)
• unassigned simulation objects
• sets (of Simulation Objects)
• path snippets
• paths
• evaluations

Sets, Path snippets and Paths can be renamed or deleted. Evaluations can be deleted.
Additionally simulation objects, Path snippets and Sets can be added to a set.

For unassigned Simulation Objects, select Assign type to convert the selected objects
to, for instance, Origins. The same dialogue menu as in assigning a simulation object
will appear.

For Simulation Objects with assigned type, there are five possible actions you can take:
Edit, Add to set , Create Evaluations, Rename and Delete. With Edit a dialogue
menu will present the parameters for the first Simulation Object. Any changes made
for this Simulation Object apply to all selected objects. Warning: parameters will be
overwritten in this instance!

The Create Evaluations action creates Evaluation Polygons that precisely fit the
selected Simulation Object’s geometry.
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10 Settings

The first section of the Edit menu allows you to edit various simulation parameters.
With the Settings options, your simulation can be refined as required.

With the settings menus, you can alter a great number of your simulation’s parameters.
If you choose not to set any parameters, default settings are applied. There are three
distinct categories: Agent settings, Behaviour settings, and Simulation settings.
The options for each are provided below:

10.1 Agents

Within the simulation it is important to model the correct population of agents. To do
this, the modeler must create one or more personas. Each persona describes a group of
people with similar characteristics. A classic persona would be as example elderly people
or students.

After creating the personas, the corresponding persona distribution can be set in each
origin.

The agent settings dialog allows to view, edit, create and remove personas using the
buttons underneath the table.

A persona summarizes several characteristics of the persons, which will be discussed
individually in the following.

10.1.1 Body

The body describes the space requirement of a pedestrian. Each pedestrian is modeled
as circle in crowd:it. Therefore, to indicate the area required, the diameter of the circle
must be specified.

To ensure that not all pedestrians within a persona are of identical size, a appropriate
size distribution can be used. For a more detailed description of the distributions, see
section distribution.
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10.1.2 Velocity

The speed describes the walking speed of a pedestrian on level ground. Thus, it describes
the speed of the person without the influence of obstacles, other pedestrians, slope, etc.

To ensure that not all pedestrians within a persona walk at the exact same speed, a
appropriate distribution can be used. For a more detailed description of the distributions,
see section distribution.

10.1.3 Behaviour

Accessible simulation objects Here different simulation object types can be excluded. If
a simulation type is not selected, agents of this persona will not simulation objects
of this type.

Social distancing The COVID-19 Pandemic led us to incorporate physical distance
keeping for our agents. Therefore, we integrated a Social Distance Model that let
agents keep a minimum distance between each other if possible. The value can be
set between 0 and 2.5 m. More information about the model can be found here. For
our implementation, agents try to keep distance and only undermine the distance
keeping if it’s getting too dense or if a bottleneck has to be be walked through. If
no social distancing should be kept the value can be set to 0.

10.2 Groups

Here we find the distribution of groups. The left column (Size) indicates the size of the
group, and the right column ( Ratio) describes the proportion of agents in a group of
that size. Naturally, the ratios must sum to 1.0.

10.3 Queue behaviour

Distance between queuing agents [m] describes how far apart two agents stand in a
queue [meters] (default: 0.1) So that agents act naturally, up to 125% of this value
may be considered by individual agents.

Max queue deviation [°] describes the greatest angle, projected from an object, within
which a queue can form for that object [0-180 degrees] (default: 30)

Queue width factor affects the shape of queues (default: 1.0)
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10.4 Simulation settings

Use dynamic navigation field toggles an algorithm that makes the simulation far more
realistic but increases computation time significantly ( default: TRUE)

Use undirected navigation field toggles an algorithm that speeds up simulation calcula-
tion when you have many origins or destinations (over 100) ( default: FALSE)

Update rate navigation field specifies the rate at which the dynamic floor field values
should be re-calculated. The rate is per time-step, i.e. 1 means one calculation per
time-step. By increasing the rate, the simulation is more realistic but computation
time increases (default: 1)

Compress output will zip the simulation output when checked (default: ON). Helps
when producing large files.
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11 Simulation calculation

11.1 Run simulation

With Simulate > Run simulation the simulation will be calculated.

A window will open. Here, enter how many seconds should be simulated. Press Enter
and the simulation will run, displaying a green progress bar with options Details... and
Cancel. The simulation will terminate when all agents have reached their destination,
the time has run out, or you select Cancel.

Details... offers a further window, which displays information about the simulation’s
progress. If a problem emerges, this window will also allow you to send a report to
accu:rate.

Providing everything works, when the simulation has finished, the completed results will
automatically open and the Simulation menu will change slightly.

11.1.1 Automatic path finding across multiple floors

By default, floor connectors, such as stairs, escalators and elevators, must be placed on a
path for agents to use the connectors. Optionally, when configuring the simulation run,
using the Advanced section, you can enable Automatically find floor connectors.
Agents will then automatically select a floor connector - even if it is not on the path.
Several stair flights should be connected to a pathsnippet, so that agents use the whole
stair, and not only the floor connecting stair flight. If multiple connectors are available,
agents will select the closest simulation object. This behavior can be customized by
putting all available connectors between two floors into one set - for example, all stairs
connecting the first floor to the second floor. The selection process defined in the set
then determines which of the stairs is selected by the agent.

11.2 Run simple assessment

As an alternative to a regular simulation, a simplified assessment can be performed. For
this purpose, no complex paths have to be created, but agents automatically choose
the shortest path to the closest destination. Thus, only origins, destinations and floor
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connectors have to be created - agents find the way to the next destination automatically;
if necessary also across several floors.

11.3 Statistic runs

It is often desirable to create several statistic simulation runs from one scenario. With
Statistic runs is it possible to run one scenario with different statistical distributions.
Other than Run Simulation, which uses the exact same distribution each time it is run,
Run Statistic offers variability. Specifically, run simulation uses a fixed seed for the
random generator, while run statistics uses an arbitrary one and thus achieves slightly
modified results on each run.

Here the simulation time must be set as usual, followed by the number of simulation
runs. Simulation runs are then calculated one after another.

Once the final simulation is completed, it will automatically display, and the Simulation
menu adjusts accordingly. There you can select the different runs.

11.4 Continue editing

Once run, a simulation’s Simulation Objects and Paths may no longer be edited. Evidently,
to edit them would create a discrepancy between the simulation results and the geometry
from which the results were calculated.

If you do try to edit the simulation, a warning with the following options will appear:

• Delete all simulation results and edit file
• Copy this project without simulation results
• Cancel

In any case, simulation results can be deleted under Simulation > Delete results.
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12 Visualization

Having run a simulation of crowd behaviour, use in-built crowd:it tools to alter the
visualisation of your results using the Visualize menu item. In this step, we will also
discuss adding a background image, and how to create videos and photos.

12.1 Agent

By selecting Agent Visualization. . . a dialog to adjust the color of agents and their
traces is displayed. With the reset-button you can reset the dialog to the default settings.
But only by pressing apply the reset values are applied.

12.1.1 Agent color

Here, agents can be coloured according to certain characteristics. Characteristics in-
clude:

• origin
• destination
• path
• persona
• navigation state
• velocity: The faster the agent, the lighter its colour.
• social distancing: Colors the agents based on close distance
• group: With lines connecting each individual to every other individual in the

group.
• group size: This is group size, not group.
• time of exit: The sooner the exit, the lighter the colour.
• custom: Choose a custom colour for agent colouring.

Where appropriate, a legend will appear in the bottom left, clarifying the meaning of
any colouring.
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12.1.2 Agent traces

For ease, we have made it possible for you to visualise the literal paths of agents in
real-time. Check Draw agent traces to show these paths.

The following display options are available:

• Color: Choose, if the trace colour will be the same as the agent colour, or specify
a separate trace colour.

• Style: Select fading to allow any traces to fade with time. Otherwise, the entire
path will be displayed.

• For: Select active, to draw traces only for agents that are still active in the
scenario. If you have selected specific agents using Identify Agents, the selected
option will unlock.

12.2 Display

In the next section of the Visualize menu the following menu items are available:

• Visualize > Show legend (show/hide the legend in the bottom left of the display)

• Visualize > Show scale (show/hide the scale of the geometry in the bottom right
of the display)

• Visualize > Show evaluations (show/hide Tripwires or other evaluation lines)

• Visualize > Background image (display a background image if you have set
one)

• Visualize > Logo (display a logo if you have set one)

Each of these commands is independent of any other.

12.3 Object label

With Visualize > Show object labels. . . a dialogue window will open, allowing you
to show or hide further labels. These labels cover all classes of object from walls and
unassigned Simulation Objects, to Origins and Stairs.
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12.4 Background image

A background image set behind the scenario is sometimes useful. Since the dimensions of
your image and scenario are unlikely to agree, it is possible to calibrate the size, position
and rotation of your image. To do this, the image and scenario are displayed in two
windows, each with a “calibration line” drawn above them.

There are two ways to overlay an image onto your scenario. The faster option is to adjust
the calibration line in the simulation display itself. Since the image adjusts live, you can
simply calibrate it by eye. However, this is only helpful for a rough calibration. If you
want to make a fine calibration the second option is better. For this method drag both
ends of the calibration line (red and blue) on a “real” line or corner in the image. It is
helpful if these points are quite far apart from each other. Next drag the respective ends
of the calibration line on the same line or corner in the scenario. You should try to hit
exactly the same point in the image and in the szenario.

Finally, adjust the transparency of the image to avoid “visual competition” between the
background image and the scenario. When you are happy, select Apply.

12.5 Logo

With Visualize > Set Logo. . . you can add a logo to your simulation. Your logo will
remain in the same position for each floor. By default, this is in the upper-right corner.

You can adjust the size of your logo by selecting it. This reveals a blue rectangle in each
of the logo’s corners. Hold the mouse on one of these rectangles and drag the logo to the
desired size. You can adjust the position of your logo by selecting the logo and moving it
with your mouse.

Once you are happy with the size and position of your logo, exit editing mode by clicking
anywhere outside the logo. To change the logo’s transparency, see Visualize > Logo.

The logo must be edited only once as it is a cross-project setting.

12.6 Zoom factor

You can zoom in and out of the simulation display by setting the zoom. Zoom ranges
from 0.0 magnitude (fully zoomed-out) to 1.0 (fully zoomed-in).
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12.7 Colors

You can alter the colour palette of your simulation under Visualize > Set colors. . . .
Here you can change the colours of Simulation Objects, Simulation Object types, the
background, the walls and evaluations. To change the colour of individual elements of
the simulation, enter the element’s name in the available field. Additionally all elements
can be hidden as in CAD programms. Attention: Hidden Simulation Objekts will not be
shown, but still influence the simulation.

In addition, the colors of Simulation Objects can be changed by right-clicking on the
Simulation Object and select Set color. . . .

12.8 Animation speed

You can speed up or slow down the simulation run time using Visualize > Set animation
speed. . . .
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13 Analyze

Once your simulation is complete, and any visualisation settings defined, you can evaluate
your results.

13.1 Agents

In crowd:it it is possible to analyze the behaviour of individuals and groups of individuals.
The following menu entries describe how.

13.1.1 Identify Agents

Using Identify Agents you can consider individual agents and their personal details.
After selecting Identify Agents, click on any agent you wish to know more about. A
table in the right panel displays the key data of the agent and a yellow trace displays
the Path so far. To identify multiple agents, drag a rectangle over the agents you wish
to highlight, or hold Control and individually select additional agents. De-selection is
similarly available. When selecting multiple agents, three buttons display underneath
the agents’ key data: <-, Statistics and ->. To navigate between each agent’s key
data use the <- and -> buttons. To display statistics about all selected agents, select
Statistics.

13.1.2 Search Agents

If you are interested in a particular agent, and know its ID, use Search Agent. . . to
locate it and display its details and Path as in Identify Agents.

13.2 Evaluation objects

To evaluate areas of your scenario, crowd:it provides various evaluation objects, as
described in the following menu entries.
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13.2.1 Tripwire

Tripwires consider how many unique agents have passed a line. You can count agents who
move over the tripwire in one direction only, or in either direction. To count agents trav-
elling in one direction only, specify the orientation as Clockwise or Counter-clockwise.
An arrow will appear on your tripwire indicating the direction in which agents will be
counted.

• Orientations include:

– clockwise: counts agents that move clockwise across the tripwire.
– both: counts all unique agents that pass over the tripwire.
– counter-clockwise: counts agents that move anti-clockwise across the trip-

wire.

Select Tripwire to draw a line directly onto your plan.

A dialogue will then display, that edits the name, colour and orientation of your tripwire.
To see all options right-click on the tripwire.

This menu allows you to move, view, delete and alter the properties of your tripwire,
respectively. By selecting Move, blue circles at either end of the tripwire can be used
to move the tripwire. When you are satisfied with its location, click away from the
tripwire.

If you select the option ‘Copy to floor. . . ’, a new dialog will be opened. In this dialog
you can select the floors to which this simulation object should be copied.

After applying, new simulation objects are created on the selected floors. These objects
have the same properties as this simulation object.

You can also export screenshots and videos of the tripwire using this dialogue. Here, the
bounding box of the tripwire is used as area for the screenshot or video.

Display a summary statistics including: number of agents passing over the Tripwire and
times when the first and last agent pass the Tripwire, export the data of the tripwire to
a csv file and create the following predefined charts:

• Basis diagrams:

– Number of peds: the number of unique agents passing over the tripwire
against time.

– Velocity: offers speed statistics of agents at the point they cross the tripwire
(minimum, arithmetic mean, median, maximum).

• Weidmann Diagrams:

– Velocity vs. Flux

49



13.2.2 Rectangle

With Rectangle, you can create a box that acts like a tripwire with orientation both.
The evaluating Rectangle can be drawn directly onto the plan and for editing options,
see Tripwire.

In addition to the pre-defined charts associated with tripwires, Rectangles have:

• Basis diagrams:

– Standard Density: Standard density calculations (agents per square-metre)
within the rectangle’s area.

– Voronoi Density: Voronoi density calculations within the rectangle’s area.
Caution, this value is liable to inaccuracy if the evaluation area is too small
or lies over the top of obstacles.

– Length per stay: creates a data point each time an agent enters the Rectangle
and records the length of stay of each visit.

– Aggregated stay: provides one data point per agent and aggregates any
time it spent in the Rectangle.

• Weidmann Diagrams:

– Density vs. Flux
– Density vs. Velocity

13.2.3 Polygon

With Polygon you can form a closed shape that acts analogously to evaluation rectangles.
While creating your Polygon, any number of vertices can be added. Pressing Delete on
the keyboard removes the last added vertex. To close the Polygon, simply click near the
first point, or press Enter.

Warning: Polygons must be convex, otherwise evaluations will not be calculated. (A
convex Polygon contains no corner that is directed inward.)

13.3 Charts

Use charts to quickly and clearly present the results of your simulation. You can select a
pre-defined chart (see Tripwire, Rectangle) or create a custom chart.
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13.3.1 Create chart

Use Create chart. . . to create a custom chart. Afterwards a dialog will appear. The
dialog guides you through the chart creation.

In the first step you have to decide, if you want to create a chart from a template for
a specific area type or create a complete custom chart on your own. Choosing custom
chart will guide you directly to the chart customization dialog (see next chapter). While
chart templates allows to select a chart template fitting for your area type and area(s) to
be evaluated.

13.3.2 Chart customization

In the Customization dialog there are different options to customize your chart:

• Selection of the chart type - e.g. point cloud, bar chart or line
• Selection of the possible data series that are available
• Refining the data series (Apply functions like min, mean, max or median to your

data series)
• Style data series (color, name, icons etc.)
• Layout and title of the chart

To see how your current selection affects the chart click Calculate in the right pane.
However, be careful because there is no reset. So use the Calculate button often, so you
can easily change it back manually if you don’t like the result.

To switch between configuration panels, you can use the step selector on the left side of
the window. To display the final chart press the button with the check symbol at the
bottom of the panel.

13.3.2.1 Select chart type

The first configuration panel allows to select the type of chart to be created.

You can choose between the following chart types:

• Line, Scatter and Mixed charts: are best suited for the presentation of pure
number data series, Here you can choose between line, scatter and mix charts. Line
charts connected all data points with a line, while scatter charts display each data
point as an individual small circle. The last option allows to combine line and
scatter data series within one chart.
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• Area charts: are best suited for the presentation of pure number data series.
Here you can choose between standard and stacked. We recommend coloring
the areas beneath each data series, when stacked is selected. So that there is no
misinterpretation of the results.

• Bar chart: are best suited for the presentation of data series that map a category
to a number. Here you can choose between standard and stacked.

13.3.2.2 Select data

Now it comes to the most complicated panel, the selection of the data series. For a
description of the available data series, see following section Data Series. Here, many
different data series are available, already presorted by the selection of the chart type.
To find the desired data series more quickly, you can filter by the evaluation area type
(floor, origin, elevator, etc.) or x- and y-axis dimension.

The panel is structured as follows, on the left side there are all possible data series, while
on the right side there are listed all data series already added to the chart. A more
detailed description of the individual data series and their use cases can be found in the
section “Data series”.

To add a data series to the chart simply select the data series in the left panel and
double-click on the data series or press the + button. The

Note: Only those data whose domain and range types are the same can be displayed
on the same graph. As such, once a data type resides on the right, only those options
on the left whose domain and range matches the selected data will display. E.g. If the
selected data has “time” as their x-dimension, you will be unable to select data whose x
-dimension is density.

13.3.2.3 Refine data

The next panel allows to add a function that should be applied to the data series. For
example, should the values be summed up in a certain window, or should the average
value be formed, or should the minimum and maximum values be displayed? This can
be set here. Due to our modular structure, individual time intervals of the aggregation
can be set.

There are two different options to set the aggregation time intervals basic and advanced.

With our basic option the user has to define only the aggregation window and tick size
(see help dialog for future information).

While the advanced option allows the user to define the start and end positions of each
interval.
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13.3.2.4 Design data

In this section the visualization settings for the individual data series can be defined.
This means the labeling as well as coloring and display of the individual data series. Here,
different options are displayed depending on the selected chart types.

13.3.2.5 Design chart

In the last section overall visual aspects of the chart are defined. This includes the title,
axis labeling and size of the chart.

13.3.2.6 Final chart

To complete and therefore finalize the chart simply press the check button right to the
arrow buttons.

Afterwards the final chart will be shown. It may take a while for your chart to display if
crowd:it must process a large amount of data. Don’t worry, results are coming!

At the bottom of this window the chart can be exported. There are different methods
available to do this, each of which can be simply copied to the clipboard or saved to a
file.

The first option “PNG” simply saves the current chart as image. While “CSV” and “CSV
raw data” allow to export the data series shown in the chart. The option “CSV” exports
the result data series after applying the aggregation function, while with “CSV raw data”
the base data can be exported.

Or save the configuration with the star icon (see Reporting for further description).

13.3.3 Data Series

13.3.3.1 Number of agents and flow of agents

(Number of) Agents over time: This is the number of agents in a given geometry (scenario,
floor, rectangle, polygon or tripwire) over time. The Mean and Max functions can be
used to determine the average and maximum number of people over time (Interval (in
seconds)).
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13.3.3.2 Travel times

Travel times can be determined by creating tripwires at the starting point (A) and the
end point (E). A tripwire chart shows how many people cross each tripwire at what time.
To determine how long people are traveling from A to B, a tripwire bi A and B can be
created, and then a tripwire tour chart can be generated. In addition, the times of the
last agent movement can be displayed for each floor via Floor exit times.

13.3.3.3 Velocity

Velocity over time: This is the velocity of the agents in a given geometry (floor, rectangle,
polygon) over time.

13.3.3.4 Length per stay and congestion evaluation

Length per stay: This is the amount of time an agent stays in a certain area (floor,
rectangle, polygon) over time.

Aggregated stay: This is the total amount of time an agent stays in a given area (floor,
rectangle, polygon) over time.

Max individual congestion duration: This is the longest single period of time that an
agent moves at a speed less than the limiting congestion speed.

Total congestion duration: This is the total number of times an agent is below the
congestion speed limit.

Agents in congestion over time: This is the number of agents that are in congestion at a
given time.

13.3.3.5 Density

• Standard density over time: people per square meter over time.

• Voronoi density over time: space available to a person over time. Heatmaps of
density illustrate where bottlenecks are located.
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13.3.3.6 Weidmann diagrams

Diagrams according to Weidmann can be displayed for comparison with pedestrian
data:

• Flux vs. density: this is the flow of people over the density of people.

• Mean density vs. velocity: This is the mean person density versus pedestrian
velocity.

• Flux vs. velocity: This is the flow of people over the velocity.

13.3.3.7 Social Distancing

• Agents over maximum exposure duration: This is the number of people over their
maximum single exposure to another person. A distance underrun is when a person
falls below the adjustable minimum distance to another person for at least one
adjustable minimum exposure duration (min exposure duration).

• Agents over aggregated exposure duration: This is the number of persons over the
aggregated duration of the distance shortfalls to other persons.

• Agents breaking social distance over time: This is the number of persons over time
who are currently breaking the distance to another person.

• Agents too close over time: This is the number of people over time who come closer
to a person than the required minimum distance.

• Duration of social distance breaking over time: This is the maximum single distance
breaking duration over time.

13.3.3.8 Elevator

The following data series are available for elevators:

• Agents inside elevator: Represents the agents currently traveling with the elevator
over time.

• Agents waiting on floor : Represents the number of waiting pedestrians on a specific
floor over time.
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13.3.3.9 Queue

The following data series are available for queues:

• Queuing agents: This data series displays the length of the queue over time. It can
be used to display, at which time of the simulation the queue is the longest.

• Length per stay in queue: Similar to Length per stay, this data series represents
the waiting time in relation to the arrival time.

13.4 Summary tables

The menu option “Create summary. . . ” opens a dialog that displays a dialog that lets
you choose between several automatically generated tables. All alternatives are split into
different categories and are further explained in the following.

13.4.1 Area summary

Provides a summary of each evaluation rectangle and polygon (an ‘area’). Each area is
detailed with:

• The mean number of agents in the area.
• The maximum number of agents in the area at the same time.
• The minimum, mean and maximum time spent within the area over all agents.
• Number of agents observed in this area
• Number of visits in this area

13.4.2 Tripwire summary

Provides a summary of a tripwire. It contains:

• The total number of agents counted.
• The time when the first agent was counted.
• The time when the last agent was counted.

13.4.3 Path summary

Here each Path is detailed with:

• The number of agents following the Path.
• The minimum, maximum and average times in seconds to complete the Path.

As with Tripwire summary use Edit to specify the time of observation.
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13.4.4 Origin destination summary

Here for each Origin and final Destination combination is detailed with:

• The number of agents moving from this origin to this destination.
• The minimum, maximum and average times in seconds to complete the way.

As with Tripwire summary use Edit to specify observation settings (like including the
premovement time in the travel time).

13.4.5 Elevators summary

In this table a detailed report about each Elevator can be found.

Following information is presented:

• Total number of agents that have used the elevator over the complete simulation
time.

• Mean and max time spent waiting for the elevator (Measured from the time of
arrival at the elevator to the time, when the pedestrian starts to enter the elevator.
Important: all other pedestrians are allowed to leave the elevator first) .

• Mean and max time spent boarding the elevator (Measured from the time the
pedestrian starts to enter the elevator till the pedestrian’s torso is within the
elevator.

• Mean and max time spent traveling within the elevator (Measured from the time
the pedestrian’s torso is within the elevator till the pedestrians starts leaving the
elevator. This includes stops on other floors).

• Mean and max time spent deboarding within the elevator (Measured from the time
the pedestrians starts leaving the elevator till the pedestrian’s torso has left the
geometry of the elevator).

13.4.6 Elevator stops summary

In this table it is presented how many times each elevator stops on a given floor. Important:
If a elevator does not open the doors on a floor, the floor is not counted even if the
elevator passes this floor.
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13.5 Heatmap

Heat maps allow the simulation results to be interpreted. For this purpose, the observation
area of the scenario is divided into square tiles. These tiles are then coloured according
to a selected criterion. In this way, for example, congestion areas can be identified, which
can then be examined more closely with evaluation objects.

The criterion for colouring is selected in the heat map dialogue. You can open the
dialogue via the menu Analysis -> Heatmap. . . .

The menu is split into three sections:

• Measurement: In measurement, you can specify the Heatmaps type, time span,
and tile size. Click on Advanced Settings to unlock all available settings.

– Type: Define the criteria for your colouring. (Options are described in more
detail under section Colouring criteria).

– From: and To: Specify the time in seconds over which you wish to calculate
Heatmap values.

– Moving average: Specify the time span, the chosen value is averaged.
‘ ’Example:’ ’ If you chose 10 seconds, then - for each time step - the succeeding
10 time steps are considered and averaged.

– Tile size: Set the size of the measuring tiles in meters.

– Ignore agents in premovement time: Check this, to exclude agents that
haven’t yet moved.

• Colouring : Here, a preview of the Heatmap’s legend is provided. If you wish to
change the colouring, click the Edit button and a new dialogue will open.

• Floors: Define on which floors the Heatmap should be calculated.

If you are happy with your settings, click Ok to view your Heatmap.

13.5.1 Coloring criteria

• Mean length of stay: Over the simulation run, the time each agent remains
within each tile is averaged.

• Mean length within social distance: Per tile it is calculated how long agents
did not keep the social distance defined in Personas. Of all times and all pedestrians
the mean value is calculated and displayed.

• Agents: Over all time steps, the number of agents entering each tile is counted.
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• RSET: Required Safe Egress Time. The time at which the final agent passed the
corresponding tile.

• Density: Over all time steps, the density of each tile is recorded. That is, the
number of agents in each tile at any one time is averaged. (Mean or maximum
density are available as comparison criteria between tiles). Density-Heatmaps can
be coloured by Level of Service as defined by Fruin.

• Velocity: Over the simulation run, the speeds of each agent entering each tile are
averaged. (Minimum, mean or maximum velocities are available as comparison
criteria between tiles).

• Mean Congestion duration: Over the complete simulation time, the seconds are
counted in which any agent was in a traffic jam within this cell. For the cell value
the mean value of all pedestrians, that where in jam in this cell is used.

13.5.2 Coloring

This menu is divided into four sections:

• Scheme:

– Default: The default colour scheme is white, blue, and black. It is either
relative(the maximum value is set as the maximum achieved value) or absolute
(the maximum value is set by the user).

– ‘Custom’: A user-defined colour scheme. If you change any of the following
settings, the colour scheme will become user-defined.

– Level of Service: These colour schemes can be chosen for density Heatmaps:
∗ Walkway: Service levels for walkways.
∗ Queueing: Service levels for queuing.
∗ Stairways: Service levels for walking on stairs.

• Gradient: Specify if the changes in colour are continuous or discrete.
• Colour stops: Here you can define the colour stops. First, determine whether to

describe the colour values relatively (the maximum value is set in the dialog) or
absolutely (the maximum value is set as the maximum achieved value). Secondly,
define the stops. Stops can be added, removed or edited.

• Legend preview: Here you can see the preview for the legend of the Heatmap.

You can close the Heatmap by selecting Clear from the above menu. To alter the
Heatmap, re-select Create Heatmap. . . .
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13.6 Evaluation Settings

In the pop-up window, you can specify settings used for all evaluations. That means
these settings are used in charts, tables as well as heatmaps.

13.6.1 Social distancing

In the first section all settings for social distancing can be found:

’ ‘ ’Social Distance’ ’ ’ :specifies at which distance (midpoint to midpoint) the agent is
counted as violating the social distance

’ ‘ ’Min. exposure time threshold for calculation’ ’ ’ Set the number of seconds an agents
has to violate the social distance before he is considered as an agent that breaks social
distance

’ ‘ ’Exposure time threshold for visualisation:’ ’ ’ Set the time at which the circles around
pedestrians (if Colour by Social Distance is ticked) will turn red

’ ‘ ’Exclude Agents on same path:’ ’ ’ If you want to exclude agents that are on the same
path, you can tick the option below. Then, all agents with the same path assigned will
be ignored for the calculation of the exposure.

These settings do affect ‘ ’Heatmaps’ ’ and ‘ ’Color by Social Distance’ ’.

13.6.2 Congestion

In the second section all settings for congestion evaluation can be found:

’ ‘ ’Max. velocity for congestion duration (m/s):’ ’ ’ Describes the maximum velocity
underneath a pedestrian is considered to be in a congestion.

’ ‘ ’Max. velocity for congestion duration on stair (m/s):’ ’ ’ Describes the maximum
velocity underneath a pedestrian is considered to be in a congestion, when moving on a
stair.

’ ‘ ’Min. time threshold for congestion (s):’ ’ ’ Describes the minimum time an agent must
stay below the velocity limits before being considered to be in a traffic jam.

Note that an agent’s velocity must undercut both the absolute and the relative value to
be considered in congestion.
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13.7 Reporting

Often, you will need to simulate multiple scenarios of the same situation, outputting
the same reports. In order to save time, crowd:it allows you to save your screenshot,
video and chart settings. This feature is named Reporting. Reports can be viewed,
re-opened, and re-exported across multiple scenarios.

13.7.1 Save report

The star button can be found in all dialogues in which the Reporting function is
available. This button allows you to save the current setting as a report.

In order for a report to be recognised, a corresponding name must be entered by the
user. The report is then added to the saved reports.

13.7.2 Saved reports

All saved reports can be viewed, re-opened, re-exported and deleted under Analyze >
Saved reports. . . .

You can select a single or multiple reports to export or view by using the checkboxes. A
double click will open the relevant dialogue menu for that report.

The list of reports can be filtered using the search bar on top of the dialog.

A pop-up menu can be opened by right-clicking in the table so that existing reports can
be renamed or duplicated.

Furthermore, created reports can now be saved or imported as JSON. In this way, saved
reports from one project can be integrated into another. Above all, this can be applied
to reports using evaluation polygons/rectangles, too. It is important for this that all
designations for evaluation polygons and floors are the same from project to project.
Excluded from this feature are video reports following an agent.

See advanced Tools for more information.
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14 Export

Once you have visualised and analyzed your simulation, you may wish to export a video
or screenshot of the results. Export your simulation to produce an overview of results,
highlight certain time-steps or neuralgic points, or produce deliverables, such as heatmap
displays and agent traces. Under crowd:it’s File menu, this is easily done.

14.1 Screenshot

The menu item File > Take screenshots. . . __takes screenshots of multiple (or all) floors
at the current time or at various intervals.

Firstly you need to specify under which file name the screenshots should be saved.
Afterwards, you can select which floors and settings you wish to screenshot and specify
whether the screenshots should be of the current time or over a series of intervals. Click
on the Advanced settings button to unlock a series of additional settings.

The Image size settings allow you to specify the desired resolution of the screenshot.
The width and height are locked to the aspect ratio of your floor. Alternatively, you can
set the resolution by specifying, how many pixels of the resulting image should make up
one meter in your floor. Changing the Pixel per meter will automatically adjust the
width and height, and vice versa.

To gain an impression of your current settings, find the live preview on the right. If you
selected a Heatmap in the Advanced settings section, you can press the Recalculate
Heatmap with current settings-button, to generate a preview of the Heatmap.

Once configured, you can save this report with the star icon (see Reporting for further
description) or export them directly by choosing Take screenshots and choosing a
folder afterwards.

14.2 Video

Finally, you have the option File > Export video to file. . . .

Here you can specify under which file name your video(s) will be saved; clarify which
floors to show; select the time span of the video; configure the visualization settings;
and specify the desired resolution, as in Screenshot. Additionally, there is the option to
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Follow traced agent. This option will be available only if, in your main visualization
window, you are tracing a single agent (to do this see Identify Agents). When selected,
the video will track that agent between floors. For example, if a traced agent is on Floor 1
for the first thirty seconds of your simulation and then on Floor 2, the video will similarly
display Floor 1 for the first thirty seconds and Floor 2 for the remaining time.

Save your configuration using the star icon as ever (see Reporting) or directly create the
videos with Export and choose a folder afterwards. crowd:it is locked during export.

After export, you can open and play the finished videos in a player. You will find in the
lower-left of the exported videos the current second and the current number of agents in
the simulation.
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15 Troubleshooting

15.1 Slow simulation calculation: Performance tips and tricks

Sometimes the calculation of simulations seems much slower than usual, but there are
usually simple explanations for this.

To get your results faster, you can check / adjust the following things.

15.1.1 Check geometry

For simulation, each additional line in your CAD tool affects the simulation time. This
also applies to lines that are located in areas that cannot be accessed (e.g. drawing cables
in walls).

15.1.1.1 Reduce lines within the simulation

Usually, the fastest way to speed up simulations is to move all objects that are not needed
/ located in inaccessible areas to hidden layers in the CAD tool. This way they remain
in the CAD tool but do not influence the simulation time anymore.

15.1.1.2 Check line duplication

Often duplicated lines are found in CAD plans, which lie on top of each other and thus
offer no further added value. Tip: Most CAD tools offer simple commands to remove
such objects.

15.1.1.3 Check coordinate system origin

Within crowd:it the same coordinates are used as in the CAD plan. This means that a
polyline in your CAD tool has exactly the same coordinates as in crowd:it.

This simplifies the search for certain objects in the CAD program, but also has a decisive
disadvantage. If the coordinates in your CAD program are very large, this also means
large coordinates in crowd:it. Since the simulation file contains much more information
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than the CAD file (pedestrian positions), large coordinates can result in a significantly
higher memory requirement for your simulation file. In addition, very large coordinates
can also lead to rounding errors in the simulation calculation.

Therefore, we recommend moving the geometry in the CAD tool to the coordinate system
origin.

15.1.2 Check simulation settings

This section should be viewed with caution, as an incorrect setting of the simulation
settings can have a strong influence on the simulation results. Nevertheless, it should be
mentioned, as a lot of performance can be gained here.

15.1.2.1 Floor discretization

Especially in large viewing areas, it is usually not necessary to use very fine granular
navigation because there are no narrow paths such as between stage seats.

In these scenarios, the discretization of a floor can be increased from the default value
of 0.1 meter to 0.5 meter. ( This setting can be found in the floor properties of the
corresponding floor).

This can speed up the calculation of the navigation extremely.

15.2 Out of memory error

Especially with larger simulations sometimes the error “Out of Memory” can occur.

Reasons for this can be endless, but the most common reason is that the calculation
doesn’t get enough memory assigned.

If you experience an out of memory error, please contact us (product-support@accu-
rate.de) and we will look for a solution together.
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16 Advanced tools

16.1 Automatic report generation via console

16.1.1 Shipped JARs

Initially, when installing on Windows, the JARs are located at AppData > Roaming
> accu-rate > crowd-it > bin, which are divided into the respective subdirectories
gui or kernel.

16.1.2 Workflow

The workflow for this is as follows:

• Open project via crowd-it

• Create saved reports

• Mark the desired reports under Analyze > Saved Reports. . .

• Right click > Export as JSON. . . > select folder and save JSON file

• Open console

The following graphic gives you an overview:

66



If you use the GUI jar directly via the console, you can make use of the automatic report
creation.

java -jar <path-to-gui-jar>
--filename=<path-to-crowdit-file>
--jsonFile=<path-to-exported-json-file>
--exportReports

If you append the following command to the chain, a maximum image size can be
specified (separator x is mandatory).

--resolution=<width>x<height>

There is also an overview of all used JSON tokens:
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17 Glossary

Agent: Simulated pedestrian

Capacity: Capacity limitation. As example: how many agents can enter the waiting
zone at the same time.

Destination: Destinations that host agents; sinks where the agents are removed from
the simulation

Deviation: Standard deviation

Directed Scaled Area: Directed scaled areas, which can indicate different direction to
specify different braking/acceleration factors

Disable Dynamic Flooding: Disables dynamic flooding for this target off.

Floor: Combination of all geometry of a simulation viewing area, which are on one
level.

Heatmap: Space map with color coding by density, speed, or other aspects of the
simulation.

Premovement Time: Reaction time to a specific event (e.g. alarm system) that triggers
the agents to start walking

Name: Name of the simulation object

Origin: Sources where agents were generated either at the beginning or the simulation
time the agents are generated

Path: The connection between the source and the target along which the agents from
the source should run. Possibly with intermediate destinations like stairs, portals and
waiting areas.

Portal: Seam that connects two floors with each other.

Queuing Line: Element that represent the start of a queue

Scaled Area: Areas within which agents can be slowed down or accelerated

Set: Group of simulation objects (sources, targets, stairs, . . . )

Simulation object: Simple polygons in the CAD program, which can be later in crowd:it
to sources, targets, stairs etc. stairs, etc. in crowd:it
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Stair: Object that represents a rectangular stair

Time of Exit: Time at which the agent arrives at the safe area / final destination

Time to Wait: Waiting time

Traces: Footsteps of a pedestrian

Waiting Zone: Area in which pedestrians wait a specific time
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